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Introduction 
This AutoReceive User Manual provides information on configuring and using Care360® AutoReceive. It also describes how 
to add, modify, and remove subscriptions that deliver results to your printer or computer from various service providers, or 
subscriptions that allow you to upload clinically relevant documents to Care360 EHR (Electronic Health Record). In addition, 
it describes how to upload point-of-care testing (POCT) results to Care360 Lab Orders and Results.

Intended Audience 
This user manual is intended for end users of AutoReceive who receive results, upload clinical documents, and/or upload 
POCT results. The manual assumes your computer, printer, and network (if applicable) are set up and ready to use, and that 
you are familiar with the basic skills needed to use them.

Note: For an explanation of subscriptions, see “Configuring Subscriptions” on page 8.
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What’s New in This Release 
AutoReceive 8.0 provides the following updates and enhancements:

• Platform support. AutoReceive platform support has been updated as follows:

• AutoReceive now supports the following operating systems:

• Windows® 8 and Windows 8.1. For information on the Windows 8 and Windows 8.1 conventions used in this 
manual, see “Documentation Conventions” on page viii.

• Windows Server® 2012 R2.

• Windows Small Business Server (SBS) 2011 Standard. 

• Windows 2000 has been removed from the list of supported operating systems. If you are currently running 
AutoReceive on Windows 2000, you can continue to use it, but no new installations of AutoReceive on 
Windows 2000 will be performed.

For more information, see “System Requirements” on page 5.

•  Start and stop options. AutoReceive now supports the following options for managing how the AutoReceive service and 
user interface are started and stopped:

• Manual stop and restart option. A new option for forcing the AutoReceive service to stop and restart is now available 
in the Windows Start menu (or in the Apps screen for Windows 8, Windows 8.1, and Windows Server 2012 R2). For 
more information, see “Starting and Exiting AutoReceive (Service Mode)” on page 49.

• Additional options for starting the AutoReceive user interface. Several options have been added to support users' 
attempts to start the AutoReceive user interface when another instance of AutoReceive is already running. For more 
information, see “Starting and Exiting AutoReceive (Classic Mode)” on page 52.

• Automatic recovery. AutoReceive can now automatically recover from system-level error conditions. For more 
information, see “Automatic Restarts of AutoReceive” on page 54. “Automatic Recovery” on page 71

• Retry attempts. If results fail to download, AutoReceive now continues retrying instead of exiting. This is especially 
beneficial for subscriptions that are configured to download results only once or twice a day.  
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Documentation Conventions 
This manual uses the following conventions: 

• Manual titles, special terms, Web page and dialog box titles, menu items, toolbar button names, labels that appear on 
Web pages and dialog boxes, and keyboard key names appear in italic.

Italic is also used to indicate variables. For example, an email address might be presented as name@company.com. When 
typing the address, you would use the actual user name and company name rather than name and company.

• Words that are being emphasized appear in bold.

• Text that you type as well as messages and prompts that appear on the screen appear in this type style.

• The greater than symbol (>) indicates a series of menu items to click. For example, the instructions to click the File menu 
item and then click Open might be presented in the following way: “Click File > Open.” 

• This manual calls your attention to important information in several ways:  

• The following Microsoft® Windows operating systems are referred to collectively as User Account Control (UAC) 
operating systems:

• Windows 8

• Windows 8.1

• Windows 7

• Windows Vista®

• Windows Server 2012 R2

• Windows Small Business Server (SBS) 2011 Standard

• Windows Server 2008 R2

• Windows Server 2008

UAC is Microsoft Windows security technology that limits applications to standard user security unless you explicitly 
request that the application be run with administrator privileges. AutoReceive requires administrator privileges to run 
properly in Service mode.

• For Windows 8 and Windows 8.1, the instructions in this manual assume the following:

• You are using a keyboard and mouse, not a touch screen.

• You are using desktop mode to access the AutoReceive menu. (To access the desktop mode from the Windows 8 and 
Windows 8.1 Start screen, press the Windows logo key + d.)

• For all operating systems, the instructions in this manual assume that the notifications area is expanded to show the 
AutoReceive icon.

• When viewing this manual using Adobe® Reader®, we recommend that you do the following to ensure optimal display:

1 Click Edit > Preferences. 

The Preferences dialog box appears. 

2 In the Categories list, click Page Display.

Note: A note indicates exceptions to the stated rule, or information that emphasizes or supplements important points 
in the main text. A note can supply information that might apply only in a special case. 

Caution! A caution indicates that failure to take or avoid a specified action could result in losing data. When you see a 
caution, follow the instructions carefully.
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3 In the Rendering area, clear the Enhance thin lines check box. You may also want to clear the Use 2D graphics 
acceleration check box, based on capabilities of your graphics card. 

4 Click OK. 

Note: The preceding steps are specific to Adobe Reader X; the procedure may vary based on the version you are using.
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Abbreviations and Acronyms 
The following is a list of abbreviations and acronyms that are used in this manual. 

Abbreviation/Acronym Description

BU Business Unit

DHCP Dynamic Host Configuration Protocol

DNS Domain Name Server

DPI Dots Per Inch

EHR Electronic Health Record

EMR Electronic Medical Record

HL7 Health Level 7 Standard Interface

HTTP Hypertext Transfer Protocol

HTTPS Hypertext Transfer Protocol, Secure

KB Kilobyte

LAN Local Area Network

MB Megabyte

MCID Message Control ID

PDF Portable Document Format

POCT Point-of-Care Testing

SOAP Simple Object Access Protocol

TIQ Test In Question

TNP Test Not Performed

UAC User Account Control

UNC Universal Naming Convention

USB Universal Serial Bus
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Accessing the Documentation 
You can access AutoReceive documentation in the following ways:

• Online help. The help provides overviews and step-by-step procedures for all AutoReceive tasks. It can be viewed with 
an Internet browser.

• User manual. Like the help, the user manual provides overviews and step-by-step procedures for all AutoReceive tasks, 
but it also includes screen captures and other diagrams. It is available as a PDF file that can be viewed online or printed.

Access the Online Help 

1 Do one of the following:

• Right-click the AutoReceive icon ( ) in the taskbar and click Help.

• From any of the subscription configuration dialog boxes, click the Help link in the upper-right corner

The AutoReceive help appears in a new browser window.

2 Do one or more of the following to access a help topic:

• On the Contents tab, click the appropriate book or topic:

• To view a topic, click the page icon ( ). 

• To expand a closed book, click the closed book icon ( ). 

• To collapse an open book, click the open book icon ( ).

• On the Index tab, click the appropriate letter in the list, and then click one of the listed keywords.

• On the Search tab, type the word or phrase that you want to find, and then click Search. From the list of search results, 
click the appropriate topic name.

• From the navigation bar above the topic, do one or more of the following: 

To do this Click this

See where the topic appears in the table of contents.

Note: If the topic is not included in the table of contents, an error message appears.

Go to the previous topic in the help system.

Note: If you are viewing the first topic in the help system, this button appears dimmed.

Go to the next topic in the help system. 

Note: If you are viewing the last topic in the help system, this button appears dimmed.

Display a list of related topics that provide additional information. 

Note: You can also click the Related Topics link at the bottom of the topic.

Display the Contents, Index, and Search tabs after accessing a task-specific help topic. 

Note: This button does not appear when you access the general help. 

Print a topic
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• At the top of the help topic, click any of the links that appear within the navigation links. The navigation links show 
where the current topic appears in the hierarchy of the Contents. (You might have to scroll the window to see the 
navigation links.)

3 When you are finished viewing the help, close the help browser window by clicking the close button ( ) in the upper-
right corner of the window.

Access the User Manual 

1 Do one of the following, depending on your operating system:

• From the Windows 8, Windows 8.1, or Window Server 2012 R2 Apps screen, click AutoReceive User Manual.pdf. 

• From all other Windows operating systems, click Start > All Programs > AutoReceive > AutoReceive User Manual.pdf. 

The Care360 AutoReceive User Manual PDF file opens in the Windows Reader app or Adobe Reader. 

2 Use the bookmarks in the left pane of Adobe Reader to navigate through the chapters and sections in the PDF file.

Notes:
• The name of the currently displayed topic is not a clickable link.

• Although you can always go higher in the hierarchy, you cannot go deeper using the navigation links.
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About AutoReceive
AutoReceive, part of the Care360 suite of products, provides a secure method for the following:

• Receiving, routing, and storing lab results from Quest Diagnostics® or radiology results from other service providers. The 
lab and radiology results are available in HL7 or printable (PDF) formats, depending on how AutoReceive is configured.

• Uploading clinically-relevant scanned documents to your computer or network drive, and transferring them 
electronically into the Care360 EHR.

• Uploading point-of-care testing (POCT) results to AutoReceive using an external POCT device (such as a HemoCue® 
device) for delivery to Care360 Lab Orders and Results.

The following graphic illustrates the process of receiving lab results from a Quest Diagnostics service provider using 
AutoReceive. 

AutoReceive Subscriptions 
A subscription is a defined delivery method that identifies the lab or radiology result document types (HL7 or PDF) that you 
want to receive, or the location of the files that you can upload (scanned clinical documents).

Lab and radiology result subscriptions include how and when results are delivered to you, and how you prefer the results be 
stored, saved, or printed for clinical use. You can create any number of HL7 and PDF subscriptions, each with differing 
delivery options. Lab and radiology result subscription parameters include the following: 

• Document type (for example, HL7 or PDF)

• Subscription name

• Save or print location (defined at your discretion)

• Type of result (final results only or partial and final results)

• Frequency of transmission (for example, every 60 minutes)

• Disabled days of the week (for days your office is closed)
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• Print order (for example, by file date or file name)

• HL7 filename extension (for HL7 subscriptions only)

• Quest Diagnostics account 

A Quest Diagnostics account can be associated with only one HL7 subscription and one PDF subscription type. If you want 
reports from all of your Quest Diagnostics accounts to be delivered according to the same set of parameters, that is, at the 
same time(s) each day, to the same printer/folder, etc., you would configure only two subscriptions—one for HL7 and one 
for PDF— and associate all your Quest Diagnostics accounts with these two subscription types.

If, however, you want to specify variations to your subscriptions to accommodate differing delivery requirements among 
your clinicians, you can create and name additional HL7 and PDF subscriptions and associate them with accounts that are 
not already associated with another subscription of the same document type.

Example Subscription

If you want to receive HL7 final results (document and result type) from Quest Diagnostics for the Northern Medical Group 
(Quest Diagnostics account), you can configure an HL7 subscription to retrieve results every 60 minutes (frequency of 
transmission) to a folder on your network (save location). You might have already configured other HL7 subscriptions with 
differing parameters for other Quest Diagnostics accounts, but AutoReceive offers the flexibility to configure additional 
subscriptions to suit your clinical requirements. For more information on creating subscriptions, see “Configuring 
Subscriptions” on page 8.

The following image shows two configured subscriptions and the specified delivery parameters for the selected account. For 
more information, see “Accessing Account and Subscription Summary Information” on page 38. 
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Running AutoReceive as a Windows Service 
AutoReceive runs as a Windows® service by default (called Service mode), unless a previous installation of AutoReceive on 
the same computer ran as a standard application (called Classic mode), in which case this setting is retained. A Windows 
service is an application that runs when Windows is started, and continues to run in the background as long as Windows is 
running. Running as a Windows service enables AutoReceive to continue downloading or printing results even when no user 
is logged in to Windows.

There are no visible changes to the AutoReceive user interface when AutoReceive is running as a Windows service, except 
for some minor modifications to the status messages that appear in the status window. (For a list of these status messages 
and for information on setting their display, see “Changing Notification Options” on page 44). 

You can still access the AutoReceive menu options from the notification area (at the far right of the Windows taskbar), and 
you can start the AutoReceive application from the Start menu. The primary difference is that exiting AutoReceive (by right-
clicking the AutoReceive icon ( ) and selecting Exit) closes the user interface, but does not stop the Windows service from 
running. 

Note: The AutoReceive service operates properly on Windows UAC operating systems only if you run it as an 
administrator.
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System Requirements 
Before you can use AutoReceive, your computer must meet the hardware and software requirements listed in the following 
sections: 

• “Operating Systems”, below.

• “Printer Requirements” on page 6.

Operating Systems 
AutoReceive supports the following operating systems:

• Windows 8.1 (32-bit and 64-bit)

• Windows 8 (32-bit and 64-bit)

• Windows 7 (32-bit and 64-bit)

• Windows Vista (32-bit and 64-bit)

• Windows XP (32-bit)

• Windows Server 2012 R2 (64-bit)

• Windows Small Business Server (SBS) 2011 Standard (64-bit)

• Windows Server 2008 R2 (64-bit)

• Windows Server 2008 (32-bit and 64-bit)

• Windows Server 2003 (32-bit)

For all operating systems, your computer hardware must meet the requirements recommended by Microsoft. In addition, 
your computer must be connected to the Internet.

If you are using a modem, the minimum required modem speed is 56 KB. 

Notes:
• Quest Diagnostics will support the Windows XP (all service packs) and Windows Server 2003 operating systems as 

long as they are supported by Microsoft Corporation.

• Adobe Reader version 5.0 or newer is required for viewing documentation PDF files, and files that you download using 
AutoReceive.

• A browser is required for viewing the AutoReceive online help.
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Printer Requirements   
The printer for receiving and printing documents must be a laser printer that is connected to a workstation or office network. 
The following requirements apply: 

• Microsoft Windows-supported printer

• Network, serial, parallel, or USB connection

• Print drivers appropriate to your computer’s operating system 

• Support for landscape and portrait orientation

• 200 dpi print resolution or higher

The following is a list of the printers with which AutoReceive has been tested. However, you are not limited to the printers 
in this list.

• Lexmark® E322

• OKI® B6500

• OKI B6300

• OKI B4350

• OKI B4300

• OKI C6100

• OKI C5400 

Note: PostScript® printer drivers are not supported.
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Installing AutoReceive 
AutoReceive is installed for you by Quest Diagnostics personnel who also do the initial set up and configuration of 
subscriptions. At the end of the installation process, AutoReceive is typically running as a service and ready to receive results 
(lab or radiology) or to upload clinical scanned documents (to Care360 EHR) or POCT results (to Care360 Lab Orders and 
Results).

As AutoReceive runs in the background, operation is largely invisible and requires very little interaction from you. Otherwise, 
for a list of tasks you might need to perform, see “Using AutoReceive” on page 34.
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Configuring Subscriptions 
Configuring a new subscription is a three-step process. All three steps must be completed for the subscription to be 
considered active so that you can begin receiving results. An overview of the three steps follows: 

1 Choose Subscription. Select the subscription type (HL7, Printable, or Clinical Document Upload).

2 Configure Subscription. Specify the subscription parameters, including the retrieval schedule and the location to save or 
print the results.

3 Associate Account(s). Associate the subscription with one or more Quest Diagnostics account(s). This step applies to 
HL7 and Printable subscriptions only.

At any time during the configuration process, you can monitor your progress by reviewing the Steps to configure AutoReceive 
area at the top of the configuration dialog box. A check mark appears next to each completed step. 

Step 1: Choose Subscription
The first step in creating a new subscription is to select the subscription type, either HL7, Printable (PDF) test results, or 
Clinical Document Upload. Based upon this selection, the appropriate parameters appear for the second step of the 
configuration process.

Step 2: Configure Subscription
You can uniquely configure each subscription to meet the needs of your office. You need to consider and make selections 
for the following parameters for each subscription you configure:

• Subscription name. The default name is HL7 Test Results for an HL7 subscription, Printable Test Results for a PDF 
subscription, or Clinical Document Upload for a Clinical Document Upload subscription. You can change the name to 
something more meaningful to you if you want. For example, if you have multiple service providers from whom you are 
receiving results, you may want to identify the subscription by the service provider’s name. An example might be Quest 
Diagnostics HL7 Test Results.

• File naming mode. Two naming modes indicate how HL7 and PDF files are named: Standard and Enhanced. The Standard 
naming mode uses a timestamp to name the file, while the Enhanced mode adds a Provider Account ID, Message 
Control ID (MCID), and Document ID (PDF files only) to the file name to aid in matching an HL7 file to any corresponding 
PDF file(s). 

Examples of the Enhanced file formats are shown below:

• HL7: Provider Account ID-MCID-timestamp.hl7

• PDF: Provider Account ID-MCID-Document ID-timestamp.pdf

Caution! If you close the Subscription Configuration dialog box prior to completing the configuration, your configuration 
changes are not saved. The three configuration steps listed above have associated parameters from which you must make 
selections. See the descriptions below for the selections available for each of the three configuration steps.

Note: The file naming mode you select applies to all subscriptions you configure; that is, you only need to set it once. 
You do not need to select it separately for each subscription.
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Enhanced file naming examples:

• HL7: 10088-10200001-1342806194056.hl7

• PDF: 10088-10200001-87235-1342806194056.pdf

• Print Order. If you selected the Enhanced file naming mode, you can choose the print order in which your results are 
sorted. You can choose to sort results by File Date or File Name. (For standard file naming, the default is to print the results 
in the order in which they are received.)

• Retrieval schedule. The retrieval schedule is defined by your selections for both a retrieval time and a result type. Choose 
a retrieval time by selecting either a specific time or an interval. Examples include:

• Specific time. You may want to receive results first thing in the morning and at the end of the day. To do this, you can 
select 8:00 A.M. and 6:00 P.M. as the specific times for receiving your results. 

• Interval. You may want to receive results every four hours. To do this, you can set an interval by selecting a duration, 
for example, every four hours, and a starting time, for example 8:00 A.M. The starting time is used to calculate each 
interval in a 24-hour period. For this example, results save at 8:00 A.M, 12:00 P.M., 4:00 P.M., 8:00 P.M., 12:00 A.M., 
and 4:00 A.M.

Additionally, you can determine the result type by selecting either Final Results Only or Partial and Final Results for the 
specified retrieval time.

• Final results only. If you make this selection, you receive results only when all the results are complete for a specific 
requisition. If you choose this option, you may want to place orders that require more than one day to complete on a 
separate requisition. This way, you do not delay the receipt of the patient’s labs that have quicker turnaround time.

• Partial and final results. If you make this selection, you receive the latest result at the time of retrieval, whether it is 
a partial or final result.

• Disabled day(s) of the week. You may want to disable result retrieval on days that your office is closed. To do this, select 
the day, or days of the week to disable the results retrieval. You cannot disable results retrieval for all the days of the 
week. To disable retrieval for more than 6 days, for example, if your office will be closed for a week, exit AutoReceive until 
you want to resume results retrieval again. See “Starting and Exiting AutoReceive” on page 49.

• Save location. Determine where you want to save and/or print your HL7 and PDF results. Due to the format of HL7 files, 
they cannot be printed; they can only be saved to a folder on your computer or network.

HL7 subscriptions have additional configuration options available such as filename extensions and sorting of saved 
results. For more information on the HL7 configuration options, see “Configuring HL7 Test Results” on page 11.

Note: When you select a specific time or interval, AutoReceive retrieves results within a range of nine minutes prior 
to nine minutes after the selected time.

Notes:
• The starting time (for intervals) does not designate the first time the results are saved. You receive results at the 

next scheduled interval after you complete the configuration. For example, if the intervals are 8:00 A.M., 12:00 P.M., 
4:00 P.M., 8:00 P.M., 12:00 A.M., and 4:00 A.M. (every four hours) and you are setting the configuration at 
9:00 A.M., you receive results for the first time at 12:00 P.M.

• If you shut your computer down (without exiting AutoReceive) in the evening and then restart it in the morning, new 
results save at the next scheduled interval.
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Step 3: Associate Account(s)
The final step of the configuration process is to associate a account, or accounts, to the new subscription. You can choose 
from the list of available accounts that appears on the Associate Accounts dialog box. You can select multiple accounts for an 
individual subscription, but each account can be associated with only one HL7 subscription and one PDF subscription.

Once a subscription is saved, you can access it later to make any necessary modifications. See “Managing Subscriptions” on 
page 38 for more information on modifying existing subscriptions. To create new subscriptions, see one of the following:

• “Configuring HL7 Test Results” on page 11.

• “Configuring Printable Test Results” on page 16. 

Note: This step is not required for a Clinical Document Upload subscription. 
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Configuring HL7 Test Results 
HL7 test result files are saved to a specified location on your computer or network where they can then be retrieved by your 
electronic medical record (EMR) system or any other system that reads HL7 test results. Due to their format, HL7 files 
cannot be printed.

To review the detailed descriptions of subscription parameters, see “Configuring Subscriptions” on page 8. Two parameters 
that are specific to HL7 subscriptions are the following: 

• HL7 file extensions. The default value for the HL7 file name extension is hl7. If your EMR system does not recognize files 
with an .hl7 extension, type the HL7 filename extension that is appropriate for your receiving system (for example .res 
or .hll).

• Result sorting. HL7 results can be sorted into sub-folders for each account that is associated to the subscription. If you 
want to sort your HL7 results in this manner, select the Automatically create file sub-folders using Account IDs check box 
available in the Distribution area of the Subscription Configuration dialog box. See “Configuring HL7 Test Results,” step 9 
for more information. 

Configure HL7 Test Results 

1 If the AutoReceive Configuration dialog box is not already open, right-click the AutoReceive icon ( ) in the notification 
area, and then click Configure Subscriptions.

2 In the Create a New Subscription list, click HL7 Test Results. 
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3 In the File Naming Mode area, click either the Standard or Enhanced option button to indicate how result files are named. 
(For information on the naming modes, see “File Naming Mode” under “Step 2: Configure Subscription” on page 8.) 

4 In the Print Order area, click either the File Date or File Name option button to indicate how results are sorted or printed.  

5 Click Continue.

6 In the Subscription Name box, type a subscription name for the HL7 results, or leave the default name HL7 Test Results.

7 Set the retrieval schedule by doing one of the following:

• Receive results at specific times. To receive results at specific times, do the following:

a Click the At specific times option button, and then click Choose. 

b In the Select Time(s) dialog box, select the check box next to each desired retrieval time. 

Notes:
• The file naming mode you select applies to all subscriptions you configure (including HL7 and Printable). If you have 

selected the mode previously, you do not need to select it again.

• If you change the file naming mode, the setting takes effect immediately (that is, the next time results are 
downloaded).

• If you want to be able to configure the order in which results are sorted or printed, click the Enhanced option button.

Note: To use this feature, you must first select Enhanced as the file naming mode.  
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c For each selected time, click either Final Results Only or Partial and Final Result, as follows. In the Select Time(s) 
dialog box, select the check box next to each desired retrieval time. For each selected time, specify whether you 
want to receive Final Results only or Partial and Final Results. 

• To receive only final result reports, click Final Results only. All tests on the requisition must be complete to 
receive results.

• To receive the latest results, whether partial or final, click Partial and Final Results.

d When you are finished selecting the results type for each specific time, click OK.

• Receive results at regular intervals. To receive results at regular intervals, do the following:

a Click the Every option button, and then click the interval duration and starting time. 

b Determine the type of report you want to receive, as follows: 

• To receive only final result reports, click the Final results option button. All tests on the requisition must be 
complete to receive results.

• To receive the latest results, whether partial or final, click the Partials and finals option button.

8 To disable retrieval for specific days of the week, select the appropriate day of the week check box(es). 
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9 In the Save results in box, do one of the following to specify the location to save the HL7 results: 

• Type the local directory or network path.

• Click Browse to locate the local directory or network path.

The network path must be formatted as follows:

• Non-UAC operating systems (Windows XP and Windows 2003). You can enter the network path using a mapped 
drive letter, or you can enter the path using the universal naming convention (UNC). 

• UAC operating systems. You must enter the network path using the UNC. 

The format for the UNC is \\servername\directorypath.

Examples:

• Network path with mapped drive letter: Y:\AutoReceive HL7 Results

• Network path with UNC:  \\OfficeServer_1\Physicians\AutoReceive HL7 Results

10 To test the directory or network path, click Test. 

If you specified a directory that does not exist, the directory is created, and a sample document (test.hl7) is downloaded 
to the specified directory. 

11 To sort the HL7 results into sub-folders by the account associated with this subscription, select the Automatically create 
file sub-folders using Account IDs check box.

12 In the HL7 File Name Extension box, type the file name extension used by your EMR system (if it is different from hl7). 

13 When you are finished configuring the HL7 subscription and have successfully tested it, click Continue.

The Associate Accounts dialog box appears.

14 Do one of the following to select the account(s) with which the subscription is to be associated:

• Select the individual check box for each account.

• Click Select All to select all accounts.

Note: You must also configure the AutoReceive service to log on as the user account that has read and write 
permissions to the network path. Otherwise, AutoReceive can run only in Classic mode. For instructions, see 
“Configuring AutoReceive to Write to a Network Drive” on page 27

Note: If AutoReceive is running as a Windows service and you specified a network drive in step 9, clicking Test may not 
accurately confirm the ability to save a results file because the account under which the service runs may not have the 
same access permissions as the current user. If you encounter problems saving files to a network drive, make sure that 
the AutoReceive service is configured to log on as the user account that has read and write permissions to the network 
path as explained in “Configuring AutoReceive to Write to a Network Drive” on page 27. If that does not work, try saving 
to a local drive, or switch AutoReceive to Classic mode instead of Service mode. For information on switching 
AutoReceive modes, see “Switching Between Service Mode and Classic Mode” on page 55.
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If you want to clear the selected accounts, click Clear All, and then make your selections again. 

15 Do one of the following: 

• To return to the previous configuration screen to make changes prior to saving, click Back. Any changes made to the 
account associations are not saved.

• To save your selections and return to the first configuration screen, click Save.

If you specified a directory (in step 9) that does not yet exist on your computer, you are prompted to create the new 
directory. To create the new directory, click Yes to All. 

A message appears indicating that the folder(s) have been created.

• To exit the subscription configuration (without saving your changes) and return to the first configuration screen, click 
Cancel.

The Manage Subscriptions dialog box appears, displaying a summary of the subscriptions created so far. Click a 
subscription name to display the corresponding summary. 

16 Click Close to exit the Manage Subscriptions dialog box. 

Notes:
• Accounts that appear shaded and display the status of Pre-Assigned are not available for selection; they are already 

associated with another subscription.

• If your accounts do not appear for selection on the Associate Accounts dialog box, contact customer support.
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Configuring Printable Test Results 
Printable (PDF) results can be saved to your computer or network drive, and can be printed automatically on a local or 
network printer. To review the detailed descriptions of subscription parameters, see “Configuring Subscriptions” on page 8.

Configure Printable Test Results 

1 If the AutoReceive Configuration dialog box is not already open, right-click the AutoReceive icon ( ) in the notification 
area, and then click Configure Subscriptions. 

2 In the Subscription type list, click Printable Test Results. 

3 In the File Naming Mode area, click either the Standard or Enhanced option button to indicate how result files are named. 
(For information on the naming modes, see “File Naming Mode” under “Step 2: Configure Subscription” on page 8.) 

4 In the Print Order area, click either the File Date or File Name option button to indicate how results are sorted.  

Notes:  

• The file naming mode you select applies to all subscriptions you configure (including HL7 and Printable). If you 
selected the mode previously, you do not need to select it again.

• If you change the file naming mode, the setting takes effect immediately (that is, the next time results are 
downloaded).

• If you want to be able to configure the order in which results are sorted or printed, click the Enhanced option button.

Note: To use this feature, you must first select Enhanced as the file naming mode. 
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5 Click Continue. 

6 In the Subscription Name box, type a subscription name for the PDF results, or leave the default name Printable Test Results.

7 Set the retrieval schedule by doing one of the following:

• Receive results at specific times. To receive results at specific times, do the following:

a Click the At specific times option button, and then click Choose. 

b In the Select Time(s) dialog box, select the check box next to each desired retrieval time. 

c For each selected time, click either Final Results Only or Partial and Final Result, as follows. 

• To receive only final result reports, click Final Results Only. All tests on the requisition must be complete to 
receive results.

• To receive the latest result, whether it is partial or final, click Partial and Final Results.

d When you are finished selecting the results type for each specific time, click OK.

• Receive results at regular intervals. To receive results at regular intervals, do the following:

a Click the Every option button, and then click the interval duration and starting time. 

b Determine the type of report you want to receive, as follows: 

• To receive only final result reports, click the Final results option button. All tests on the requisition must be 
complete to receive results.

• To receive the latest result, whether it is partial or final, click the Partials and finals option button.

8 To disable retrieval for specific days of the week, select the appropriate day check box(es). 
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9 Determine how you want the results to be distributed (to printer(s) and/or to disk) by doing one or more of the following:

• Printer. To automatically print test results to one or more printers, do the following:

a Select the Print check box, and then click a local or network printer. To select more than one printer, press and hold 
the Ctrl key while you click the printers.

b If applicable, specify the Number of copies you want to print for each test result (maximum of 10 copies). 

c If you selected two or more copies for each test result, you can have your results collated by selecting the Collate 
Multiple Reports check box. 

d To generate a summary of your printed test results, select the Enable Print Summary Page check box. 

An example of the Result Summary Report is shown below.

The Result Summary Report displays a summary of printed Lab results contained within a batch including Test in 
Question (TIQ), Test Not Performed (TNP), and Abnormal results. The Result Summary Report also displays a 
summary of Radiology results contained within a batch listed separately from the Lab results.
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In the event there are no results for a result type (that is, lab or radiology), only the section heading appears.

e To generate an advisory message report alerting you that your batch contains Abnormal, Test in Question (TIQ), 
or Test Not Performed (TNP) results, select the Enable Advisory Message Page check box.

An example of the Advisory Message Report is shown below.

The Advisory Message Report highlights patient orders being requested in a batch that contain Test in Question 
(TIQ) and Test Not Performed (TNP) results.

• Disk. To save the results to a local or network drive, do the following:

a Select the Save files to disk check box

b Do one of the following:

• Type the directory or network path where you want to save the files. For example, type C:\AutoReceive 
Printable Results.

• Click Browse to locate the directory or network path where you want to save the printable results.

Notes:
• Reports with an advisory message (TIQ, TNP) print before the rest of the results within the batch.

• If you have requested advisory messages for a result category, and there are no messages for that category when 
the report is run, no corresponding heading for that category appears in the Advisory Message Report.
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10 To test your configuration settings, click Test. 

A sample document (test.pdf) is downloaded and one or both of the following occurs depending on the selected 
configuration settings:

• If you selected to save results to disk, the sample document is stored in the specified directory, and the following 
message appears. 

• If you selected to distribute results to a printer, the sample document is sent to the specified printer.

11 When you have finished configuring the Printable subscription and have successfully tested it, click Continue.

The Associate Accounts dialog box appears.

12 Do one of the following to select the account(s) with which the subscription is to be associated:

• Individually select the account check boxes.

• Click Select All to select all accounts.

If you want to clear the selected accounts, click Clear All, and then make your selections again. 

13 Do one of the following: 

• To return to the previous configuration screen to make changes prior to saving, click Back.

• To save your selections and return to the first configuration screen, click Save. 

If you are prompted to create a directory in which to save the results, click Yes to all. When you are finished 
configuring subscriptions, click Close from the configuration screen.

Caution! If AutoReceive is running as a Windows service and you specified a network drive in step 9, clicking Test 
may not accurately confirm the ability to save a results file because the account under which the service runs may 
not have the same access permissions as the current user. If you encounter problems saving files to a network drive, 
try saving to a local drive, or switch AutoReceive to Classic mode instead of Service mode. (For more information, 
see “Switching Between Service Mode and Classic Mode” on page 55.)
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• To exit the subscription configuration (without saving your changes) and return to the first configuration screen, click 
Cancel.

14 If you specified a directory (in step 9) that does not yet exist on your computer, you are prompted to create the new 
directory. To create the new directory, click Yes to All. 

When you have completed the subscription, the Manage Subscriptions dialog box appears, displaying a summary of the 
subscription you created. 

Notes:
• If you want to clear the selected accounts, click Clear All and make your selections again.

• Accounts that appear shaded and display the status of Pre-Assigned are not available for selection; they are 
already associated with another subscription.

• If your accounts do not appear for selection on the Associate Accounts dialog box, contact customer support.
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Configuring Clinical Document Upload
Non-electronic, clinically-relevant documents (scanned documents) can be uploaded to your computer or network drive, 
and transferred electronically into the Care360 EHR. To review detailed descriptions of subscription parameters, see 
“Configuring Subscriptions” on page 8. 

Configure Clinical Document Upload

1 If the AutoReceive Configuration dialog box is not already open, right-click the AutoReceive icon ( ) in the notification 
area, and then click Configure Subscriptions.

2 In the Create a New Subscription list, click Clinical Document Upload. 

3 Click Continue. 

4 In the Subscription Name box, type a name for this clinical document upload subscription, or leave the default Clinical 
Document Upload name. 

Note: This option is available only if you are using Care360 EHR and your account has the document upload service 
activated. 
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5 In the Parent Path box, type a directory path or click Choose to select the directory where AutoReceive looks for 
documents to be uploaded to the hub. 

A folder named Document Upload is created within the selected parent path. Files copied to this directory are sent to the 
hub.

To upload a file, AutoReceive must have the ability to gain exclusive access to the file. The Windows user that 
AutoReceive is running under must have write permissions to the directory involved. Also, the file cannot be marked as 
Read Only. The file must be copied completely to the directory before it can be uploaded to the hub.

A sub-folder named errors is created inside the Document Upload folder. Files that cannot be processed because they are 
too large (larger than 5MB) are placed in this folder. 

• Files that can’t be processed because of communication failures or the inability to establish an exclusive lock remain 
in the Document Upload folder and the system tries to re-send them.

• Any folder within the Document Upload folder is not processed.

6 In the Provider Account list, click a provider account. This identifies the organization in Care360 where the documents are 
to be sent. 

When you have completed the subscription, the Manage Subscriptions dialog box appears, displaying a summary of the 
subscription you created. 

Notes:
• AutoReceive must be able to have an exclusive lock on a document before it can be uploaded. The folder selected 

as the parent path must have proper permissions set so AutoReceive can establish an exclusive lock on the 
documents.

• You can only have one parent path per subscription.

Note: The client is responsible for ensuring documents are placed correctly in this directory.

Note: You can only have one provider account defined for a subscription. 
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Configuring Point-of-Care Testing (POCT) Results
Point-of-care testing (POCT) results can be uploaded to AutoReceive using an external POCT device for delivery to Lab 
Orders and Results. 

Configure POCT Results

1 Start the POCT device software (refer to the device’s user manual for specific instructions).

2 Connect power to the POCT device’s docking station.

3 Insert the USB cable from the external POCT device’s docking station into a USB port on the computer that is running 
the device software (refer to the device’s user manual for specific instructions).

4 From the toolbar, click Tools > Primary Docking Stations.

The Primary Docking Station dialog box appears.

Note: For information on configuring and installing the software for a specific POCT device, refer to the device’s user 
manual.
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5 Double-click the Serial Number of the docking station, or click the Serial Number and then click Edit. (The Serial Number 
is 10-digits and can be found on the bottom of the docking station.)

The Primary Docking Station Settings dialog box appears.

6 If Not Used is selected in the DHCP list, complete the following with information provided by the customer site:

• Address

• Subnet mask

• Default Gateway

• DNS

The information in these fields is specified for the docking station, not the computer that is running AutoReceive. For 
example, if DHCP is not used, you must have an IP address assigned for the docking station. This IP address goes in the 
Address field.

7 In the O.R. Address box, type the IP Address of the computer that is running AutoReceive.

8 In the O.R. Port box, type 12500.

9 Click Send.

10 After clicking Send, perform the following steps:

a Disconnect the USB cable from the computer.

b Disconnect the power cable from the docking station.

c Connect the network cable to the docking station.

d Re-connect the power cable to the docking station.

11 Use a POCT device to obtain a measurement so that the device has data to send. Then, insert the POCT device into the 
docking station. 

The results are uploaded to AutoReceive and then automatically routed through the hub where they are queued for 
delivery.

12 Right-click the AutoReceive icon ( ), and then click View Status Log. 
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The Status Log appears. Status messages appear for results that were delivered successfully, and error messages appear 
for deliveries that were unsuccessful.  
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Configuring AutoReceive to Write to a Network Drive
By default, the AutoReceive service runs as the Local System account and does not have privileges to write to a network 
drive. To allow the AutoReceive Service to write to a network drive, the service must be re-configured to run using an account 
that has read and write permissions to the specified network drive.

To re-configure the service, log in to Windows as an Administrator and stop AutoReceive (both the user interface and service 
if running in Service mode). For more information, see “Starting and Exiting AutoReceive” on page 49.

Configure AutoReceive to Write to a Network Drive

1 Do one of the following, depending on which operating system you are using:

• From Windows 8, Windows 8.1, or Windows Server 2012 R2 desktop mode:

a Right-click the taskbar and click Task Manager. 

b In the Task Manager dialog box, click the Services tab. (If the Services tab is not visible, click More Details.)

c If you are using Windows Server 2012 R2, right-click AutoReceive and click Open Services.

• From all other Windows operating systems, navigate to the Control Panel as you usually do, and then navigate to 
Administrative Tools > Services. (For example, if you are using Windows 7, you would click Start > Control Panel > System 
and Security > Administrative Tools > Services. If you are using Windows Server 2008, you would click Start > Settings > 
Control Panel > System and Maintenance > Administrative Tools > Services.)

2 Right-click AutoReceive, and then click Properties.
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3 In the AutoReceive Properties dialog box, click the Log On tab.

4 Click the This account option button, and type the name of the account that has read and write permissions to the network 
drive.

5 In the Password box, type the password, and then in the Confirm password box, type the password again.

6 Click OK.

The account you entered now appears in the Log On As column in the list of services. 

7 Start AutoReceive. If AutoReceive is running in Classic mode, set it to run as a Service:

a Right-click the AutoReceive icon ( ) and click Advanced Settings.

The Advanced Settings dialog box appears.

b Click the Service option button and click OK.

8 Right-click the AutoReceive icon ( ) and click Configure Subscription.

9 In the Save results in box, type the network path of the file in which you want to save your results.

Note: Use UNC (\\servername\directorypath) for the network path. The path must not contain a drive letter, and the 
folder must be accessible by the account configured in step 4. 
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Uninstalling AutoReceive 
If you need to uninstall AutoReceive, use the Windows Control Panel. You must exit both the AutoReceive user interface and 
service before uninstalling. 

Uninstall AutoReceive from UAC Operating Systems

1 If AutoReceive is currently running, exit AutoReceive before you continue.

To do so, right-click the AutoReceive icon ( ) in the notification area, and then click Exit.

2 If AutoReceive is running as a service, stop the service by doing the following, depending on your operating system:

• From Windows 8, Windows 8.1, or Windows Server 2012 R2 desktop mode:

a Right-click the taskbar and click Task Manager. 

b In the Task Manager dialog box, click the Services tab. (If the Services tab is not visible, click More Details.)

c If you are using Windows Server 2012 R2, right-click AutoReceive and click Open Services.

d Right-click AutoReceive.

e Click Stop.

• From all other Windows operating systems, navigate to the Control Panel as you usually do, and then navigate to 
Administrative Tools > Services. (For example, if you are using Windows 7, you would click Start > Control Panel > System 
and Security > Administrative Tools > Services. If you are using Windows Server 2008, you would click Start > Settings > 
Control Panel > System and Maintenance > Administrative Tools > Services.) Then do the following:

a Right-click AutoReceive.

b Click Stop (or Stop Service).

3 When you have exited the AutoReceive user interface and stopped the AutoReceive service, navigate to the Control Panel 
as you usually do on your operating system. For example:

• From Windows 8, Windows 8.1, and Windows Server 2012 R2, you could navigate to the Apps screen, locate the 
Windows System section and click Control Panel.

• From other Windows operating systems, you could click Start > Settings > Control Panel.

Note: You must have administrator privileges on the computer from which you want to uninstall AutoReceive.
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4 In the Control Panel, under Programs, click Uninstall a Program. 

5 In the Uninstall or change a program area, click AutoReceive from the list of programs. 

Note: If an earlier version of AutoReceive is installed to more than one user account on the same computer, only the 
first user who installed AutoReceive can uninstall from the Control Panel. If AutoReceive does not appear in the list of 
programs, it may have been uninstalled previously from another user account. In this case, do the following:
1 Access the user’s AutoReceive uninstall directory (for example, C:\Users\username\AppData\Local\

Program Files\AutoReceive\Uninstall_eMaxx_AutoReceive).
2 Double-click Uninstall eMaxx AutoReceive.exe.
3 Continue with step 7.



Getting Started 31

6 Click Uninstall/Change.

7 In the User Account Control dialog box, click Continue to verify that you want to uninstall AutoReceive. 

8 In the Uninstall AutoReceive dialog box, click Uninstall to confirm that you want to uninstall AutoReceive. 

9 When the Uninstall Complete message appears, click OK to close the dialog box. 

10 Close the Control Panel.

11 Navigate to the directory where AutoReceive was installed and delete the AutoReceive folder.

• For 32-bit version of Windows: C:\Program Files\AutoReceive

• For 64-bit version of Windows: C:\Program Files(x86)\AutoReceive

Uninstall AutoReceive from Windows XP or Windows Server 2003

1 If AutoReceive is currently running, exit AutoReceive before you continue. 

To do so, right-click the AutoReceive icon ( ) in the notification area, and then click Exit.

2 If AutoReceive is running as a service, stop the service by doing the following:

a Click Start > Control Panel > Administrative Tools > Services (Windows XP) or Start > Control Panel > Administrative 
Tools > Component Services > Services (Windows Server 2003).

b Right-click AutoReceive.

c Click Stop.

3 Navigate back to the Windows Control Panel.
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4 From the Control Panel, double-click Add or Remove Programs. 

5 In the Add or Remove Programs dialog box, click AutoReceive from the Currently installed programs list. 

6 Click Change/Remove.
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7 In the Uninstall AutoReceive dialog box, click Uninstall to confirm that you want to uninstall AutoReceive. 

8 When the Uninstall Complete message appears, click OK to close the dialog box. 

9 Close Add or Remove Programs.

10 Close the Control Panel.

11 Navigate to C:\Program Files\ and delete the AutoReceive folder.
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About Using AutoReceive 
Once configured, AutoReceive runs automatically while your computer is on, requiring no further interaction. If you need to 
add, modify, or remove a subscription, or change your connection settings, you can access the AutoReceive menu options 
by right-clicking the AutoReceive icon ( ). The AutoReceive icon appears in the notification area, at the far right of the 
Windows taskbar. 

While using AutoReceive, you may want to download results manually (that is, before the scheduled download of results), 
update subscriptions, change configuration settings, or perform troubleshooting or various other tasks. Below is a list of the 
AutoReceive tasks you might need to perform:

• Download results manually. Instead of waiting for the scheduled downloads of results, you can request immediate 
downloads, or you can request results that were downloaded previously. For instructions, see “Downloading Results 
Manually” on page 36.

• Manage subscriptions. Subscriptions need to be updated when new accounts are available, when you want to change 
the destination printer or folder for downloaded results, etc. For instructions on updating subscriptions as well as adding 
new ones or removing unnecessary ones, see “Managing Subscriptions” on page 38.

• Change notification settings. AutoReceive notifications appear in a small status window on your screen. You can change 
the default setting to display this window all the time, display it on top of other windows, turn it off, etc. For more 
information, see “Changing Notification Options” on page 44.

• Change connection settings. If your network connection changes (for example, from modem to LAN), or if login 
credentials change, see “Changing Connection Settings” on page 46.

• Start, stop, or restart AutoReceive. Occasionally, you may need to stop and restart AutoReceive. For instructions, see 
“Starting and Exiting AutoReceive” on page 49.

• Switch between Service mode and Classic mode. The most common way to run AutoReceive is in Service mode. 
However, you may need to switch to Classic mode in certain situations, such as using a Windows firewall or anti-virus 
application that impedes AutoReceive communications in Service mode. For instructions on switching between the two 
modes, see “Switching Between Service Mode and Classic Mode” on page 55.

• Troubleshoot. If you receive an error that AutoReceive cannot connect, you can respond to it by following the 
instructions in “Responding to AutoReceive Connection Failures” on page 57. Otherwise, if you are working with 
customer support, you may need to send status and error logs manually, view log files, or provide customer support with 
current configuration settings, as explained in these sections:

• “Sending Status and Error Logs Manually” on page 59.

• “Viewing the Print Log” on page 60.

• “Viewing the Status Log” on page 61.

• “Viewing the Configuration Settings” on page 63.

• Download product updates. AutoReceive updates are downloaded automatically, but you have the option to check for 
and install updates at any time. For instructions, see “Downloading Product Updates” on page 64.

Note: If AutoReceive is in Service mode (that is, running as a Windows service), the AutoReceive icon ( ) may not 
appear in the notification area. To access the AutoReceive user interface, see “Starting and Exiting AutoReceive” on 
page 49, which explains how to access the AutoReceive user interface when AutoReceive is running in Service mode as 
well as in Classic mode. For general information on Auto Receive running as a service, see “Running AutoReceive as a 
Windows Service” on page 4. 
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Downloading Results Manually 
Although AutoReceive is configured to receive results at the specific times or intervals you specify, you can request an 
immediate download or redownload of information. For instructions, see the following:

• “Downloading Current Results”, below.

• “Redownloading Results” on page 37.

• “Reprint Last Reports” on page 37.

Downloading Current Results 
Instead of waiting for the automatic or timed download of results, you can manually request an immediate download of 
results at any time. This may be useful when you are seeing a patient whose lab results are ready but not yet received. A 
manual download retrieves only completed results that have not yet printed or saved. This ensures that you do not receive 
duplicate results.

After a manual download, the next scheduled download excludes the results you already requested (this also applies for 
scheduled downloads). For example, if AutoReceive is configured to download results every two hours, but you request a 
manual download after one hour, the next download includes only those results received during the 60 minutes after the 
manual download.

Download Current Results 

Right-click the AutoReceive icon ( ) in the notification area, and then click Download Now.

The results, if available, are retrieved and saved or printed according to your subscription configuration.

Note: You cannot manually download results during the subscription configuration process. You must either complete the 
subscription configuration or cancel the configuration process prior to manually downloading results.
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Redownloading Results 
If you need to redownload results that have already been received, use the AutoReceive Redownload feature. With the 
AutoReceive Redownload feature, you can download results by date range as long as the results are not older than 90 days. 

Redownload Results 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Redownload Now.

2 In the From and To boxes, type a date range for the redownloaded documents using the format mm/dd/yyyy. 

3 Click Download.

Reprint Last Reports
AutoReceive allows the most recent set (batch) of downloaded PDF results to be reprinted. After a successful printable 
result download, the PDF results are stored in a temporary directory within the AutoReceive install directory to allow 
reprinting if requested. The Reprint Last Reports feature applies only to PDF results.

Reprint Last Reports

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Reprint Last Reports.

2 If reprinting is successful, a dialog appears informing you what was reprinted. 

If no results are available for reprinting, a dialog appears informing you that no reports are available for reprinting.

Note: If you are using the Enhanced file naming mode and need to redownload results, the redownloaded file names are 
generated using the current time. As a result, it is possible to have two identical files with different timestamps. You can 
determine which file to use by comparing the file names, and using the one with the latest timestamp. (For more 
information on the Enhanced naming mode, see “File Naming Mode” under “Step 2: Configure Subscription” on page 8.)

Note: You cannot download results that are more than 90 days old.
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Managing Subscriptions
Subscriptions are usually configured following installation and remain active until you remove or modify them. You can also 
add new subscriptions if new accounts become available.

Accessing Account and Subscription Summary Information 
You can access account and subscription summary information in two locations:

• Account Summary. The Account Summary dialog box provides a brief summary of all subscriptions that are configured 
for each account. In the Account Summary dialog box, you can determine which type of subscription is configured for the 
account, for example, HL7 or PDF, as well as the subscription name as specified during configuration. You cannot edit 
the subscriptions from the Account Summary.

• Subscription Summary. The Subscription Summary area provides a detailed view of the subscription parameters specified 
during configuration, including the associated accounts. You can edit the parameters by selecting the appropriate 
subscription and clicking Configure. See “Modifying a Subscription” on page 41 for more information.

Access the Account Summary 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Configure Subscriptions.

2 In the Manage Subscriptions area, click the Account Summary link. 

The Account Summary dialog box appears.

3 Review the accounts and subscriptions listed on the Account Summary dialog box.

Accounts are listed in alphabetical order, and the name of the subscription to which they are assigned is listed in the HL7 
and/or PDF column. Each account can be associated with only one HL7 subscription and one PDF subscription. 

4 When you are finished reviewing the summary, click Close.
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Access the Subscription Summary 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Configure Subscriptions.

2 In the Manage Subscriptions area, click the Choose from the following available subscriptions option button.

3 In the list of available subscriptions, click the desired subscription.

The parameters configured for the subscription appear in the Subscription Summary area.

4 To modify the configuration for the selected subscription, click Configure. Otherwise, when you are finished reviewing the 
summary, click Close.

For additional information on modifying subscriptions, see “Modifying a Subscription” on page 41.
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Adding a Subscription 
You can add a new subscription any time there is an available account that is not yet associated to a subscription type (HL7 
or PDF). Because HL7 and PDF subscriptions can each be associated with one or more accounts, you may need to configure 
only one HL7 subscription and one PDF subscription, so that all specified delivery options apply to each associated account. 
If necessary, you can configure multiple subscriptions, one HL7 and one PDF, for each account, specifying unique parameters 
such as print locations and result types.

Add a Subscription 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Configure Subscriptions.

2 In the Manage Subscriptions area, click the Create new subscription option button.

3 Click HL7 Test Results, Printable Test Results, or Clinical Document Upload. 

4 Click Continue.

For information on configuring the parameters for the selected subscription type, see one of the following:

• “Configuring HL7 Test Results” on page 11.

• “Configuring Printable Test Results” on page 16.

• “Configuring Clinical Document Upload” on page 22.

Note: If you select a subscription type (HL7 or PDF) that is already assigned to the available account(s), you are notified 
that it is unavailable for configuration.
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Modifying a Subscription
If you need to make changes to a subscription (for example, routing your results to a different printer), you can access the 
subscription’s existing configuration and make the necessary changes. You can also adjust the interval at which you receive 
results, or change account associations.

Modify a Subscription 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Configure Subscriptions.

2 In the Manage Subscriptions area, click the Choose from the following available subscriptions option button.

3 In the list of available subscriptions, click the subscription that you want to modify.

4 Click Configure.
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5 In the Subscription Configuration dialog box, make any necessary changes to the configuration, and then click Continue.

6 In the Associate Accounts dialog box, select or clear (as appropriate) the account(s) to which the modified subscription 
parameters should be applied. 



Using AutoReceive 43

7 Do one of the following:

• To return to the previous configuration dialog box to make changes prior to saving, click Back.

• To save your selections and return to the Manage Subscriptions dialog box, click Save.

If you are finished configuring subscriptions, click Close.

• To exit the subscription configuration without saving your changes and return to the Manage Subscriptions dialog box, 
click Cancel.

Removing a Subscription
If you are no longer receiving results from a service provider (Quest Diagnostics business unit (BU) or imaging 
center/hospital), you can remove the associated subscription from AutoReceive. Also, if there are any connectivity 
problems with a particular service provider, you can remove the subscription to avoid gathering error messages in the status 
log. When the problem is resolved, you can configure the subscription again. For information on the status log, see “Viewing 
the Status Log” on page 61.

Remove a Subscription 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Configure Subscriptions.

2 In the Manage Subscriptions area, click the Choose from the following available subscriptions option button. 

3 In the list of available subscriptions, click the subscription that you want to delete, and then click Delete.

4 When prompted, click Yes to confirm the deletion. 
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Changing Notification Options 
After AutoReceive is started, it remains running in the background until you log off or close the application. The AutoReceive 
icon ( ) in the notification area indicates that AutoReceive is running. When an AutoReceive communication session is in 
progress, that is, when results are being downloaded or when the application is being automatically updated, the 
AutoReceive icon ( ) changes to an AutoReceive communication icon ( ) until the session ends, at which time it reverts 
to the normal AutoReceive icon.

In addition to the AutoReceive communication icon ( ), you can monitor the status of communication sessions by 
choosing to display a small status window on your screen that provides information about the success or failure of 
communications activity such as connections, downloads, saves to disk, printing and system updates. 

The AutoReceive Status window consists of two lines, as follows: 

• The upper text line displays the state of AutoReceive, or what action is occurring. Idle indicates that AutoReceive is 
connected, but no data is being received at this time.

• The lower text line displays the time and completion status of the last communication session. If a communication 
session is unsuccessful, an alert message appears in this location. 

The service-related status messages that can appear include the following: 

You can drag the AutoReceive Status window from its default location above the notification area to any place on the screen. 
It remains in that position until you change it. 

You must have at least one subscription configured before you can set Notification Options. The option you set applies to all 
subscriptions; options for different subscription types cannot be separately configured.

For This Status This Status Window Appears

AutoReceive is loading

AutoReceive is in Service mode, and the service is connected

AutoReceive is in Service mode, and the service is stopped

AutoReceive is in Service mode, but the service is unavailable (this can be the 
result of various technical and security issues)
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Change Notification Options 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Notification Options.

2 Complete the Notification Options dialog box to determine when the status window appears and whether or not it appears 
on top of other windows. 

• Always. The status window appears after the startup process has completed, and remains visible until you exit 
AutoReceive.

• During AutoReceive activity. The status window appears when a communication session begins (for example, 
retrieval of HL7 or Printable results), and remains visible until two minutes after the session has completed. 

• During user-initiated activity. The status window appears only when you initiate a communication session (for 
example, Download Now, Redownload Now, Send Status/Errors, or Check for Update Now), and remains visible until two 
minutes after the session has completed.

• Never. The status window does not appear on your screen at any time.

• Always on Top. The status window stays on top of all other windows.

3 To save your selection, click Save.

Note: During AutoReceive activity is the default option. 

Notes:
• Regardless of which display option you select, you can close the AutoReceive Status window at any time by clicking 

Close in the upper-right corner of the screen.

• If you close the window manually, the window reappears at the start of the next communication session (unless you 
have chosen to never display it).
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Changing Connection Settings 
Connection settings include network configuration and login information. The network and login information configured 
during installation and setup remain active until you change them. To change the network settings or login information, see 
the following:

• “Changing Network Settings”, below.

• “Changing Login Information” on page 47. 

Changing Network Settings
The network settings determine how your computer connects to the Internet (via a dial-up modem or a LAN connection) 
and, if the connection uses a proxy server, the proxy server credentials (host name, port, user name, and password).

Typically these settings do not need to be updated unless your method for connecting to the Internet changes.

Change Network Settings 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Network Configuration.

2 In the Network Configuration dialog box, specify your connection type by selecting one of the following:

• Click the LAN option button if your computer accesses the Internet using a LAN.

Some LAN connections use a proxy server for HTTP and HTTPS connectivity. To determine if your LAN connection 
uses a proxy server, check your Internet browser’s settings by selecting Tools > Internet Options on the browser menu 
bar. Click the Connections tab. Click LAN Settings. If the Use a proxy server for your LAN check box is selected, your LAN 
connection uses a proxy server.

If your LAN connection uses a proxy server, select the Use proxy server check box, and complete the following:

a In the Proxy host box, type the name of the host for your proxy server.

b In the Port box, type the port number for your proxy server.

Note: If you receive an authentication error (your login information is not accepted), contact your system administrator 
to determine if changes have been made to your login credentials.
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If your proxy server requires you to log in, enter the corresponding username and password. This username and 
password combination is not your AutoReceive username and password.

a In the Username box, type the username for logging in to your proxy server.

b In the Password box, type the password for logging in to your proxy server.

• Click the Modem option button if your computer accesses the Internet using a modem. To automatically disconnect 
your modem after each transmission of results, select the Disconnect after finished download check box.

3 To save your changes, click OK.

Changing Login Information 
Ordinarily, only Quest Diagnostics personnel change the login information. If you need to change your login information, 
contact your system administrator to get the appropriate username and/or password before accessing the menu options to 
make changes. 

If you receive an authentication error (your login information is not accepted), contact your system administrator to 
determine if changes have been made to your login credentials. Your system administrator can provide you with valid login 
information and make sure your new information is successfully accepted.

Change Login Information 

1 Obtain the new login username and/or password from your system administrator.

2 Right-click the AutoReceive icon ( ) in the notification area, and then click Change Login Information.

3 Type the new account username and/or password, and then click OK. 

• If you entered a new username and password, a message box appears, indicating that the username has changed and 
that all existing subscriptions will be deleted. 

a Click OK to close the message box.

b Restart AutoReceive, and create one or more new subscriptions.

For information on starting AutoReceive, see “Starting and Exiting AutoReceive” on page 49.

For information on configuring subscriptions, see “Configuring HL7 Test Results” on page 11 and “Configuring 
Printable Test Results” on page 16.

Note: Changing login information affects subscriptions as follows:
• If you change only the password, your subscriptions are saved with the new password. 

• If you change both the username and password, the subscriptions for the previous username are deleted and you must 
reconfigure them.
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• If you entered only a new password, AutoReceive checks the connection with the new password. One of the following 
occurs:

• If the connection fails, a message box appears indicating that AutoReceive is unable to connect to the server. Click 
OK to close the message box. Enter the new password again and click OK. 

• If the connection is successful, no message appears. AutoReceive continues to run as usual. 
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Starting and Exiting AutoReceive 
AutoReceive can run in one of the two following modes:

• As a Windows service (referred to as Service mode)

• As a standard Windows application (referred to as Classic mode)

By default, AutoReceive is configured to run in Service mode. 

For instructions on starting and exiting AutoReceive in each mode, refer to the following sections:

• If AutoReceive is running in Service mode (that is, as a Windows service), see “Starting and Exiting AutoReceive (Service 
Mode)” below.

• If AutoReceive is running in Classic mode (that is, as a standard Windows application), see “Starting and Exiting 
AutoReceive (Classic Mode)” on page 52. 

Options for starting and restarting AutoReceive appear in the Windows Start menu. Exiting AutoReceive is accomplished via 
the AutoReceive menu.

Starting and Exiting AutoReceive (Service Mode) 
If AutoReceive is running in Service mode, there are two separate components of AutoReceive, each of which is started 
and/or exited independently: 

• Service. The first component, the AutoReceive service, starts automatically each time the computer is started and 
operates in the background. If the service should unexpectedly stop running for any reason, you are notified in the 
following ways:

• The following dialog box appears, informing you that the service has stopped: 

• The AutoReceive icon ( ) in the notification area appears with a red X ( ). 

If this occurs, the AutoReceive service can be restarted via the Restart Service option on the AutoReceive menu or via the 
Stop and Restart AutoReceive option on the Windows Start menu. 

• User Interface. The second component, the AutoReceive user interface, starts automatically each time the computer is 
started and you log in to Windows (as long as the AutoReceive option is in your Windows Startup folder). If the 
AutoReceive option is not in your Windows Startup folder (which is likely for Windows server operating systems), the 
AutoReceive user interface can be started via the Apps screen for Windows 8, Windows 8.1, or Windows Server 2012 R2, 
or via the Start menu for all other Windows operating systems.

Notes:
• For information on AutoReceive as a Windows service, see “Running AutoReceive as a Windows Service” on page 4.

• To determine whether or not AutoReceive is running in Service mode on your computer, view your current configuration 
settings as explained in “Viewing the Configuration Settings” on page 63.

• The AutoReceive service operates properly on Windows UAC operating systems only if you run it as an administrator. 
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The AutoReceive user interface continues to run until you exit it manually, or until you turn off your computer. Starting 
or exiting the AutoReceive user interface has no impact on the AutoReceive service, which continues to run regardless.

Because the service and user interface components operate independently, the following situations can occur:

• The AutoReceive service is running but the AutoReceive icon ( ) does not appear in the notification area. To access 
the AutoReceive user interface, see “Start the AutoReceive User Interface (Service Mode)”, below.

• The AutoReceive user interface may be running even if the service has been stopped. If you attempt to exit the 
AutoReceive user interface while the service is stopped, the following dialog box appears, informing you that you will not 
continue to receive subscription results until the service is restarted: 

To restart the AutoReceive service, see “Restart the AutoReceive Service (Service Mode)” on page 52.

Start the AutoReceive User Interface (Service Mode) 

Do one of the following:

• Start manually. To start AutoReceive manually, do one of the following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Apps screen, right-click the AutoReceive tile and click 
Run as administrator.

• From all other Windows operating systems, click Start > All Programs > AutoReceive, and then right-click AutoReceive 
and select the options to run as an administrator.

One of the following occurs:

• If no instance of the AutoReceive user interface is currently running, the AutoReceive splash screen appears and the 
AutoReceive icon ( ) appears in the Windows notification area. 

Note: Only one instance of the AutoReceive user interface can be running at a time.
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• If an instance of the AutoReceive user interface is running, one of the following messages appears: 

• Start automatically. To start the AutoReceive user interface automatically by restarting Windows, do one of the 
following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Start screen, Apps screen, or desktop, press the 
Windows logo key + c. When the charms appear, click the settings charm ( ) and then click Power > Restart.

• From all other Windows operating systems, click Start > Shut Down, click Restart, and then click OK.

• Force a stop and restart. To force the AutoReceive user interface and service to stop and restart (even if they are running 
in another user’s session), do one of the following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Apps screen, right-click the Stop and Restart 
AutoReceive tile and click Run as administrator. Respond to the User Account Control prompt to allow 
eMaxxAutoReceive.exe to make changes to the computer.

• From all other Windows operating systems, click Start > All Programs > AutoReceive, and then right-click Stop and 
Restart AutoReceive and select the options to run as an administrator.

The AutoReceive splash screen appears and the AutoReceive icon ( ) appears in the Windows notification area. (If the 
AutoReceive service cannot be restarted, AutoReceive reverts to Classic mode.) 

Message Description

Click Yes to restart AutoReceive. Any results 
that are in the process of being downloaded are 
downloaded when AutoReceive starts. 
Otherwise, click No to let the current instance of 
AutoReceive continue running.

Multiple users are set up on the AutoReceive 
computer, but only one AutoReceive session 
can be running at a time. Do one of the 
following:

• Click Yes to stop the AutoReceive session 
started by the specified user and start a new 
AutoReceive session under your user name. 
This has no effect on subscriptions; results 
continue to be downloaded as configured.

• Click No to let the AutoReceive session 
continue running, under the specified user.

It is not possible to restart AutoReceive via the 
Start menu. Your options are: 

• Stop the AutoReceive service via the 
Windows Control Panel.

• Stop the AutoReceive service by rebooting 
the computer.

Note: The steps above may vary slightly based on your Windows operating system.
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Restart the AutoReceive Service (Service Mode) 

If the AutoReceive user interface is currently running but the service isn’t, right-click the AutoReceive icon ( ) in the 
notification area, and click Restart Service. (If the AutoReceive user interface is not currently running, start it by following the 
instructions in “Start the AutoReceive User Interface (Service Mode)” on page 50.)

The AutoReceive service restarts and the icon appears without the red X ( ). If the AutoReceive service cannot be 
restarted, a message appears.

Exit the AutoReceive User Interface (Service Mode) 

1 Right-click the AutoReceive icon ( ) in the notification area, and click Exit.

2 When prompted, click Yes to confirm that you want to exit the user interface.  

The AutoReceive user interface closes, but the AutoReceive service continues to run in the background. Results continue 
to be received and/or printed as normal. 

Starting and Exiting AutoReceive (Classic Mode) 
If AutoReceive is running in Classic mode (that is, as a standard Windows application) on your computer, the AutoReceive 
application opens each time the computer is restarted. AutoReceive continues to run until you either exit it manually, or until 
you turn off the computer. There is no service running in the background when AutoReceive is running in Classic mode.

If you need to manually exit AutoReceive due to printer, connectivity, or network issues, you must manually restart 
AutoReceive in order to resume receiving results. To discontinue receiving results without turning off your computer, you 
can exit AutoReceive manually.

Start AutoReceive (Classic Mode) 

Do one of the following: 

• Start manually. To start AutoReceive manually, do one of the following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Apps screen, right-click the AutoReceive tile and click 
Run as administrator.

• From all other Windows operating systems, click Start > All Programs > AutoReceive, and then right-click AutoReceive 
and select the options to run as an administrator.

One of the following occurs:

• If no instance of the AutoReceive user interface is currently running, the splash screen appears and the AutoReceive 
icon ( ) appears in the Windows notification area. 

Note: If the AutoReceive icon in the notification area appears with a red X ( ) (indicating that the service has been 
stopped) when you exit the user interface, you will not continue to receive subscription results until the service is 
restarted. 
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• If an instance of the AutoReceive user interface is running, one of the following messages appears: 

• Start automatically. To start the AutoReceive user interface automatically by restarting Windows, do one of the 
following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Start screen, Apps screen, or desktop, press the 
Windows logo key + c. When the charms appear, click the settings charm ( ) and then click Power > Restart.

• From all other Windows operating systems, click Start > Shut Down, click Restart, and then click OK.

• Force a stop and restart. To force the AutoReceive user interface to stop and restart (even if it is running in another user’s 
session) do one of the following depending on your operating system:

• From the Windows 8, Windows 8.1, or Windows Server 2012 R2 Apps screen, right-click the Stop and Restart 
AutoReceive tile and click Run as administrator. Respond to the User Account Control prompt to allow 
eMaxxAutoReceive.exe to make changes to the computer.

• From all other Windows operating systems, click Start > All Programs > AutoReceive, and then right-click Stop and 
Restart AutoReceive and select the options to run as an administrator.

The AutoReceive splash screen appears and the AutoReceive icon ( ) appears in the Windows notification area. 

Message Description

Click Yes to restart AutoReceive. Any results 
that are in the process of being downloaded are 
downloaded when AutoReceive starts. 
Otherwise, click No to let the current instance of 
AutoReceive continue running.

Multiple users are set up on the AutoReceive 
computer, but only one AutoReceive session 
can be running at a time. Do one of the 
following:

• Click Yes to stop the AutoReceive session 
started by the specified user and start a new 
AutoReceive session under your user name. 
This has no effect on subscriptions; results 
continue to be downloaded as configured.

• Click No to let the AutoReceive session 
continue running, under the specified user.

It is not possible to restart AutoReceive via the 
Start menu. Your options are: 

• Stop the AutoReceive service via the 
Windows Control Panel.

• Stop the AutoReceive service by rebooting 
the computer.

Note: These steps may vary slightly based on your Windows operating system.
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Exit AutoReceive (Classic Mode) 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Exit.

2 When prompted, click Yes to confirm that you want to exit the application.  

AutoReceive closes, and the receipt of results is discontinued. 

Automatic Restarts of AutoReceive 
AutoReceive can automatically recover from several error conditions, such as out-of-memory errors or failed downloads of 
results. The automatic recovery process includes restarting the AutoReceive service and user interface when AutoReceive 
is in Service mode. When AutoReceive is in Classic mode, however, the user interface cannot be started automatically, so 
you are notified with the following message when the user interface must be restarted: 

After you click OK, be sure to start the AutoReceive user interface by clicking as explained in “Starting and Exiting 
AutoReceive” on page 49.

Note: To restart AutoReceive manually, see “Start AutoReceive (Classic Mode)” on page 52.
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Switching Between Service Mode and Classic Mode 
When AutoReceive is initially installed, it is configured to run either as a Windows service (Service mode) or as a standard 
Windows application (Classic mode), depending on whether it is a new install, or is obtaining settings from a previous install 
of AutoReceive (for more information, see “Running AutoReceive as a Windows Service” on page 4). Normally, once 
AutoReceive is successfully installed, it continues to run in its selected mode without interruption.

There are several environmental factors, however, that may impede AutoReceive’s ability to run successfully in Service 
mode; for example, if you have configured a subscription to save results to a network drive, or if you are using a Windows 
firewall or anti-virus application that impedes AutoReceive communications. In these situations, it is possible to change the 
AutoReceive operating mode from a Windows service to a standard Windows application to work around the issue. (It is 
also possible to change back to Service mode, as needed; for example, you might want to switch back to Service mode if the 
impeding issue is corrected.) 

Switch Between Service Mode and Classic Mode 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Advanced Settings.

2 In the Mode area, click either the Service or Classic option button to indicate the mode in which you want AutoReceive to 
operate.  

3 When prompted, click Yes to confirm that you want to change the AutoReceive operating mode. 

The message that appears varies, depending on whether you are switching from Classic mode to Service mode, or vice 
versa, as follows.

• Switching from Classic mode to Service mode 

• Switching from Service mode to Classic mode 

Note: The currently configured operating mode is selected by default. To close the dialog box without making any 
changes, click Cancel.
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4 When prompted, click OK to exit AutoReceive. 

AutoReceive must be closed and restarted in order to run in the new mode.

5 To restart AutoReceive, click Start > All Programs > AutoReceive > Stop and Restart AutoReceive.

For more information about starting AutoReceive in either mode, see “Starting and Exiting AutoReceive” on page 49.
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Responding to AutoReceive Connection Failures 
AutoReceive opens and connects to the server each time you start your computer. If AutoReceive cannot connect to the 
server when it starts, either after a restart or when you initially turn on your computer, you are prompted to exit AutoReceive 
or let AutoReceive try to connect to the server. AutoReceive makes connection attempts every 10 minutes for a maximum 
of one hour, after which it tries to connect every 90 minutes for an indefinite period of time or until you close AutoReceive.

After 48 hours, if a connection has not been established, a dialog box appears from which you can either close AutoReceive 
or continue trying to connect at 90-minute intervals. If you choose to let AutoReceive continue trying to connect, the dialog 
box reappears after another 48-hour interval of unsuccessful connection. Once AutoReceive begins retrying connection at 
90-minute intervals, it continues to do so until connection is established—even if you have not responded to the dialog box 
prompts—or until you close it, which you can do at any time (see “Starting and Exiting AutoReceive” on page 49). 

Respond to AutoReceive Connection Failures 

1 In the Unable to Connect dialog box, do one of the following: 

• To close the program and discontinue connection attempts, click Terminate AutoReceive.

• To close the dialog box and allow AutoReceive to continue trying to connect with the server, click Continue Retry 
Attempts.

• To update the network configuration settings, click Network Configuration. (For more information, see “Changing 
Connection Settings” on page 46.)

• To reset your password to match a new password that has been established for you by Quest Diagnostics customer 
support, click Change Password. 

2 Do one of the following, based on the selection you made in the previous step:

• If you clicked Terminate AutoReceive, do one of the following to respond to the confirmation prompt: 

• To exit AutoReceive and terminate connection retry attempts, click Yes.

Notes:
• Exiting AutoReceive before a successful connection is made and restarting it later begins the cycle of retry attempts 

from the beginning; that is, every 10 minutes for one hour and every 90 minutes thereafter.

• If you experience lengthy periods of unsuccessful retry attempts, contact customer support.

Note: The Change Password button appears only if the connection failure is due to a change in your password (for 
example, customer support may need to reset your password to resolve a connection issue). When your password 
changes, you are prompted to enter the new password the first time you attempt to log in after the change has been 
made. 
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• To keep AutoReceive running, click No.

Connection attempts are made every 10 minutes for the first hour, and then every 90 minutes thereafter, until you 
exit AutoReceive.

• If you clicked Continue Retry Attempts, but reconnection has been unsuccessful for approximately 48 hours, do one of 
the following when the message prompt appears:

• To close AutoReceive, click Terminate AutoReceive.

• To allow AutoReceive to continue attempting to connect, click Continue Retry Attempts.

• If you clicked Change Password, do the following:

a In the AutoReceive Setup dialog box, type (and then re-type) the new password, and then click Change Password. 

b In the Change Password dialog box, click OK to acknowledge the change. 

c In the Unable to Connect dialog box, click Terminate AutoReceive, and then restart AutoReceive using the new 
password.
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Sending Status and Error Logs Manually 
AutoReceive improves the process of resolving system problems and diagnosing critical errors that may occur by 
automatically collecting information about your configuration and use of AutoReceive. The collected information is stored 
in log files that are saved on your computer, and the information is periodically forwarded (automatically) to Quest 
Diagnostics customer support. By default, AutoReceive sends status information every three days, and error information 
once a day, as needed. (If no errors occur on a particular day, then no error log is sent that day.)

Though AutoReceive is configured to send the status and error data automatically, you can also request that the status and 
error information be sent immediately. This is useful when you are working with customer support on a particular issue or 
error.

Send Status and Error Logs 

Right-click the AutoReceive icon ( ) in the notification area, and click Send Status/Errors.

The latest status and error log files that are stored on your computer are sent immediately to Quest Diagnostics customer 
support. (To verify that the status and/or error logs were sent successfully, you can view the status log. For details, see 
“Viewing the Status Log” on page 61.)

If an error occurs when attempting to send status and error logs, a message appears, indicating the error condition. 
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Viewing the Print Log 
Any print jobs that are sent to the configured printer while AutoReceive is running are saved to a print log. You can 
periodically check the print log to determine whether or not the print jobs have been completed properly. If needed, you can 
redownload files using the date and time values from the Status Log to retrieve files that did not print or save. See 
“Redownloading Results” on page 37 for more information on redownloading files.

View the Print Log 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click View Print Log.

2 Review the print messages. 

3 To refresh the print messages to ensure that you are viewing the latest information, click Refresh.

4 To clear all the messages, do the following:

a Click Clear. 

b When prompted, click Yes to confirm clearing the messages. 

5 When you are finished reviewing the print messages, click Close.

Note: For instructions on configuring the printer that is used for automatic printing (for a Printable results subscription), 
see “Configuring Printable Test Results” on page 16.

Note: You cannot clear print messages individually. If you click Clear, all messages are deleted from the Print Log.
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Viewing the Status Log 
Any errors that occur while AutoReceive is running are saved to a status log. You can periodically check the status log to 
determine if any results retrievals have failed. If needed, you can redownload files using the date and time values from the 
Status Log to retrieve files that did not print or save. For more information, see “Redownloading Results” on page 37.

Additionally, the status log tracks when automatic and manual product updates are installed to your computer. Check the 
status log to see the product version that was installed and if there were any errors while attempting to update AutoReceive.

Error Messages
The following table includes some common error messages and their meanings. 

Error Description

Error while executing:<subscription 
name><message>

Problem with the subscription, or service may be down.

A Remote error occurred while trying to 
contact the web service. Please try again 
later.

Service is down.

No Service Providers were found for this 
account.

Possible misconfiguration.

Authentication failure. Incorrect credentials (for example, username or password).

Cannot retrieve document types, 
authentication failure.

Incorrect credentials.

Error printing PDF file: <message> A corrupt PDF file or printer error. If corrupt file, contact your 
system administrator.

An error occurred while retrieving 
document types.

Service could be down.

An error occurred while trying to contact 
the web service.

Service could be down.

Execution Exception: a SOAP Fault occurred 
while trying to contact the web service. 
Please try again later.

AutoReceive is having trouble connecting to the server 
either during startup or while trying to receive results.

Error while executing: HL7 Test Results A 
SOAP Fault occurred while trying to 
contact the web service.

The retrieval of results for an HL7 subscription that is 
scheduled at a particular time fails because of the SOAP 
fault.

Error while executing: Printable Test 
Results A SOAP Fault occurred while trying 
to contact the web service.

The retrieval of the results for a PDF subscription that is 
scheduled at a particular time fails because of the SOAP 
fault.

Note: For assistance understanding or resolving error messages, see your system administrator.
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View the Status Log 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click View Status Log.

2 Review the error and/or system update messages. 

3 To refresh the status messages to ensure that you are viewing the latest information, click Refresh.

4 To clear all the messages in the status log, do the following:

a Click Clear. 

b When prompted, click Yes to confirm clearing the messages. 

5 When you are finished reviewing the status messages, click Close.

Note: You cannot clear error messages individually. If you click Clear, all messages are deleted from the AutoReceive 
Status Log window.
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Viewing the Configuration Settings 
The AutoReceive Configuration dialog box, accessed from the AutoReceive Status Log, allows you to view the current 
AutoReceive configuration settings. The configuration settings are read-only, and are to be used primarily when working 
with customer support for troubleshooting purposes.

View the Configuration Settings 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click View Status Log.

2 In the AutoReceive Status Log dialog box, click View Configuration. 

3 View the AutoReceive Configuration settings. 

4 To close the AutoReceive Configuration window, click OK.

5 To close the AutoReceive Status Log window, click Close.
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Downloading Product Updates 
AutoReceive updates are typically downloaded to your computer automatically as they become available. AutoReceive 
checks for these updates approximately every two days. Although you do not have to manually install the updates, you can 
check for product updates at any time and install them if they are available. Additionally, automatic updating may not be 
available for some installations. In these cases, you are notified that an update is available via a dialog box, as well as a 
flashing AutoReceive icon ( ) in the notification area. Manual updates are performed using the Check For Update Now 
menu option. 

The Status Log tracks all product updates that have been completed. You can check the Status Log to see when AutoReceive 
was updated and if the update was successful. See “Viewing the Status Log” on page 61 for more information on reading log 
file messages.

Download Product Updates 

1 Right-click the AutoReceive icon ( ) in the notification area, and then click Check For Update Now.

AutoReceive checks to see if an update is available.

2 If an update is available, you are prompted to install it. Click Yes to begin installation. 

3 When you are notified that the uninstall is complete, click OK.

The new version of AutoReceive is installed.

4 To confirm whether or not the update was successful, right-click the AutoReceive icon ( ) in the notification area, and 
then click Check For Update Now.

If the update was successful, the AutoReceive is up to date message appears.
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Test Not Performed (TNP) result 19

U
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from Windows XP, or Windows Server 2003 31
overview 29
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Windows 7

convention in this manual viii
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We’d Like to Hear From You 

After you have used the documentation and/or help for this product, please take a moment to give us your feedback. To do 
so, click the following link to open a PDF form and respond to the questions: 

Click here to open the Feedback Form

After you have completed the form, do one of the following (from within the form) to submit your feedback:

• Email your responses. To send your responses to us electronically, click Submit by Email. 

Your default email application is used to email the form content to us.

• Print the form. To print the completed form and then mail or fax it to us, click Print Form. 

Our address and fax number appear at the bottom of the form.

Thank you!
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We’d Like to Hear From You 


After you have used the Care360 AutoReceive documentation, please take a moment to give us your comments.  
Respond to the questions below, and then click Submit by Email at the end of this form (or print and then fax or mail your 
comments to us at your convenience).  Thank you! 
 


ü What sections/topics do you refer to most often?


ü When do you refer to the documentation?  Check all that apply.


ü How is the level of detail in the documentation?


ü Does the documentation adequately explain how to get started using the product?


ü If not, what information is missing?


ü How do you primarily search for information in the documentation?


ü Was there a topic or index entry you looked for, but couldn’t find?


 Getting started  Learning about new features  Performing a specific task  Troubleshooting


Too little Just right Too much


Yes No


Full text search Table of contents Index Scan


Yes No


ü If so, what was it?


ü Did you find any errors in the documentation?
Yes No


ü If so, please list the section/topic, and describe the error:


ü Any other comments about the documentation?







Please tell us about yourself (optional)


May we contact you for additional feedback?


Send your comments to us


Email Address:


Phone:


Address:


Company:


Title/Position:


Name:


Yes No


To email them, click the Submit by Email button and follow the prompts.  To fax or mail them, click the Print Form button, 
then fax or mail them to us. 


By Mail:
Quest Diagnostics
Attn: Technical Communications Manager 
4690 Parkway Drive
Mason, OH 45040 USA


By Fax:


(800) 381-4048





